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Ask Oscar
Introduction
Ask Oscar is the ideal application to help develop children’s skills in using a 
branching database. 

The application allows children to create branching trees containing either pictures, 
text or both. It has been especially designed to allow the tree diagram to be 
saved at any point in the creative process and this offers unique opportunities for 
teachers to develop children’s data handling and observational skills in a variety of 
ways.

Ask Oscar has a powerful interactive interface, this coupled with the animated 
actors that offer children help during the process of creating and interrogating 
the database, means that the concept of the relationships between the questions, 
answers and tree diagram can be seen in an holistic context.

What is a Branching Database or Tree?
Trees are ‘structures’ used within many computer programs as a means of 
searching and finding information very quickly. Even though computers are now 
very fast, if you have millions of items stored, it will still take a long time to find a 
particular piece of data if you have to go through each item one at a time. Trees 
provide an efficient means of searching for data. Even the filing system on many 
operating systems use trees to help them locate files across the hard disc. You, the 
user, don’t see this happening, but there is some very clever stuff happening under 
the bonnet!

Why are they called trees?
Because they resemble many aspects of a real tree. Each point on the tree is 
called a node. The tree starts with what we call the root node which branches out 
to other nodes, which in turn branch out again until you reach the end of the tree. 
These points are called leaf nodes.

Trees in general can have any number of branches at each node but in Oscar each 
node is either a leaf node, (has no branches), or has two branches pointing to two 
further nodes. This type of tree is called a binary tree. We create the two branches 
at a node by giving that node a question. The question needs to be phrased such 
that it only has two answers, typically “Yes” and “No”.

If all this sounds confusing, don’t worry, because Ask Oscar is going to help you 
understand these ideas by showing you visually how a tree works.
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Here is a tree that was created in Ask Oscar.

 Musical Instruments

Electric guitar Harp

Is it electric?

Yes No

French horn Bagpipes

Is it made of brass?

Yes No

Drum Maracas

Do you hit it?

Yes No

Do you blow into it?

Yes No

Does it have strings?

Yes No

In this tree, the root node contains the question, “Does it have strings?” The 
answers “Yes” and “No” both branch down to further ‘sub-trees’. The question, “Is 
it electric?” branches down to two leaf nodes each containing an item, in this case 
an “Electric Guitar” and a “Harp”. The tree is said to be sorted when all the items 
in the tree are positioned, on their own, at a leaf node. If there are two or more 
items at a leaf node then Oscar will ask for a question to separate them.

What can we use the Branching Database for?
The branching database can be used for sorting and identifying items by looking 
at their similarities and differences. Potentially any group of objects can be sorted 
and entered into a branching database. The branching database however is only 
as good as the questions used each time to divide the items into two groups. The 
tree is most efficient when it is balanced. In order to build a balanced tree, each 
question should roughly divide the items into two equal groups. By doing this, 
each item can be found using as few questions as possible. Whilst this structure 
is efficient, it is not necessarily the one that the children will design nor in all 
instances be feasible or practical.

The tree diagram above is as efficient as it can be for the number of items in the 
tree. The tree on the next page is very inefficient.
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 Musical Instruments

French horn

Electric guitar

Drum

Bagpipes

Harp Maracas

Does it have strings?

Yes No

Do you blow it?

Yes No

Do you hit it?

Yes No

Is it electric?

Yes No

Is it brass?

Yes No

In the previous tree you could guarantee to find a given instrument with a 
maximum of three questions. In this tree, while you could find the French Horn 
with only one question, you need to ask five questions to find either the Harp or 
the Maracas. When trees become large this kind of inefficiency makes them very 
slow, you might just as well go through each item sequentially until you find the 
one you want. Another point worth noting in the above two examples, we used 
exactly the same questions in both trees but in a different order. It’s not just about 
the questions you ask, but the order in which you ask them. When you start to 
create a tree, it is not always obvious which is the best question to ask first. As we 
will see later, Oscar will allow you to move and change the questions and answers.

Creating a branching database helps children to develop their cognitive skills. 
Children are required to think carefully about similarities and differences. During 
the process children should be encouraged to develop their own questions 
although they may be directed by the teacher to consider features that they may 
have missed or be unfamiliar with. The design process starts long before the 
children actually sit down in front of the computer and start entering the data.

Throughout this tutorial we will be using worked examples. The files for these 
examples, along with the resources required, were installed along with the Ask 
Oscar application. 

We will now consider a number of ideas that could be used with a branching 
database. Example files and worked examples have been included for some of 
them.
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Ask Oscar – Main Features
The Main Toolbar

This is the main toolbar in Ask Oscar.

 This button saves the tree in its current state. This is the same as using the 
File–Save menu item.

 This button opens the Print dialogue box. This is the same as using the 
File–Print... menu item.

 This button opens the Add Item dialogue box. The Add Item dialogue box 
allows you to add a single item into the tree.

 This button opens the Add Picture Group dialogue box. The Add Picture 
Group dialogue box allows you to add an entire picture group into the tree.

 This is the Sort Tree button. It is only enabled when the tree is unsorted. 
Click this button to enter sort mode, this is detailed later.

 This is the Find button. It is only enabled when the tree is sorted. Click this 
button to enter find mode, this is detailed later.

 This button opens a dialogue box allowing you to re-sort the tree. This is 
the same as using the Tree–Re-sort Tree... menu item.

 This button will zoom in on the tree which will make the tree appear larger, 
although you may not then be able to see the whole tree.

 This button will zoom out of the tree which will make the tree appear 
smaller. This will enable you to see the whole tree but with less detail.

Because Oscar supports multiple undo, you can also add undo and redo buttons to 
the toolbar. See the section on page 18 for details on customizing the toolbar.
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Adding Items to the Tree
There are two main methods for adding items into the tree, either; using the Add 
Item sheet or the Add Picture Group sheet.

Each item in the tree must have a name (or label). This must also be unique, if you 
want to have two apples then they will need to be called ‘Red Apple’ and ‘Green 
Apple’.

Any item can have a picture but it doesn’t have to. You can use the same picture 
more than once if you wish, but this may be confusing.

The Add Item sheet is shown below:

This allows you to add a single item into the tree.

• You must give the item a name by typing into the Name field.

You can use the Load Picture... button to browse for a picture to use with this item. 
The Picture Preview shows what picture will be associated with the item. You can 
also drag a picture file from the Finder into the picture well.

• Click on the Add button to add the item to the tree.

 You will see the item being added to the tree in the background.

Adding items in this way allows you to add any items you choose, but it can take 
a long time, especially in a busy classroom. However, once you have added the 
items, you can then save the database and open it again later with all the items 
already in place. This may be something you can do before the lesson.



Page 6

The Add Picture Group sheet is shown below:

The Add Picture Group sheet is much more convenient than the Add Item sheet 
and allows you to very quickly select a group of pictures and add them into the 
tree.

• Click on the picture group you wish to add, the example above shows the 
Minibeasts. A preview of the pictures is shown on the right.

• Click on the Add button to add the pictures into the tree. You will see the 
pictures being added in the background.

You can add multiple groups of pictures into the tree if you wish, but this may be 
confusing and not be very easy to sort.

Sorting the Tree
One of the main features of using Oscar is sorting the items in the tree. The status 
bar at the bottom of the main window will tell you if the tree is sorted. If the tree 
needs sorting then the sort button on the toolbar will be enabled.

Clicking on the sort button will enter sort mode.

In sort mode, Oscar will keep asking you for questions to separate a group of 
two or more items, and then ask you to separate those items by answering the 
questions you have entered.

At any time you can press the Escape key to stop sorting if you wish.

When the tree is sorted, Oscar will exit sort mode and allow you to view the tree.
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Getting Starting
How Do I Create a Branching Database Using Ask Oscar?
It is assumed that you are already familiar with launching programs and opening 
and saving files on your computer. If this is not the case then you should refer to 
the documentation supplied with your computer system.

There are a number of ways that branching databases or decision trees can be 
introduced to children and one should be aware that introducing the same objects 
in different ways could produce very different results. 

Whilst we have included a number of example files for you to use, it is suggested 
that you follow the first two examples in this guide in order to familiarise yourself 
with the features of the software.

Resources required:
• Ask Oscar branching database application

• Musical Instruments example picture group

• A printout of the Musical Instruments tree. See the printing section on page 11.

• Optional additional musical instruments clipart files.

Skills required:
• Observational; ability to develop and phrase a question.

• Knowledge; names of some common musical instruments and their features.

The children need to be aware that questions with ‘Yes / No’ answers can be 
used to divide a set of objects into two groups and that a sequence of ‘Yes / No’ 
questions will eventually identify an object. You may wish to discuss the features 
of the musical instruments with the whole class before they begin to create a 
branching database.

• Launch Ask Oscar and add the Musical Instruments picture group from the Add 
Picture Group sheet.

The children should be encouraged to look carefully at the pictures of the 
instruments and to offer a question that will divide the items into two groups.

This worked example is offered only as a guide and it is probable that children will 
arrive at different questions to those given here.

• Click on the sort button on the toolbar. Oscar will enter sort mode and the Add 
Question sheet will open asking you for a question to separate the items. Type 
in the question you have chosen:

 Suggestion: “Does it have strings?”

• Click on the OK button.

 You will notice that two boxes appear, (by default green and red), which are 
targets for the items in the tree.
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You can either click on the appropriate response button, by default Yes and No, or 
you can drag and drop the items into the target boxes.

If you place an item in the wrong box you can drag it across to the other one.

As you place the last item you will see that the tree diagram is being updated on 
screen. This key feature of Ask Oscar offers the children the ability to see the tree 
diagram growing as they ask and answer questions. This is very important as it 
allows them to relate to and realise the implications of the answers they give to 
their questions immediately.

The New Question sheet will open again and another question must be entered 
to divide the highlighted group of items into two further groups. Enter another 
question and place each instrument in the appropriate group.

Suggestion: “Is it electric?”

The tree diagram continues to update to show the choices made and you will be 
prompted for another question. You will need to think of questions for all of the 
other groups of instruments until finally the tree has been sorted. At this point no 
more questions will be required and the status bar at the bottom of the window will 
state that the; “Tree is sorted”.

More suggestions for questions:
Does it have 4 strings?
Do you blow into it?
Is it made if brass?
Do you hit it?

Changing a Question
If you realise you have made a mistake when typing a question, you can change 
it by holding down the Control key and clicking on the question and choosing 
Change Question... from the pop-up menu. This does not change the structure of 
the tree in anyway it simply changes the text in the question.

Giving the Tree a Title
You can give the tree a title by choosing Set Title... from the Tree menu.

Now would be a good time to save the tree.

Ask Oscar’s save feature allows the tree to be saved at any point. This makes it 
extremely flexible in creating different sorts of branching databases.
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Starting Again
What can we do with the branching database once we have entered the 
information? Start again!

Using the same objects you could repeat the exercise but this time the children 
create the database without using any of the questions they used in the first 
instance.

• To start again either click on re-sort button or choose Re-sort Tree... from the 
Tree menu. 

 You now have the choice of either keeping the questions or deleting them. By 
deleting the questions you really are starting from scratch.

• Choose the option Delete the questions and click on the OK button. All of the 
objects will reposition themselves at the top of the screen.

 By deleting the questions the children will be starting again with the same items 
but have the opportunity to think of different questions.

• If the Add Question sheet does not automatically open, then click on the sort 
button on the toolbar.

• Add and answer each question in turn.

 After they have finished answering all of the questions they can discuss what 
they have discovered;

 Does the tree look like the original one?

 Were any of the questions ambiguous?

 Could it have been done better?

Test the Database
When re-sorting the tree you can opt to keep the questions. In this instance the 
items will still move to the root of the tree, but this time the tree structure will still 
be in place. If you click on the sort button the first question will appear and you 
can begin to divide the items into the two groups.

Aside: By choosing to keep the questions then you will simply be answering the 
same questions again and in the same order. This is unlikely to change the overall 
structure of the tree. However, this can be a useful tool for very young children 
who may not yet have the ability to think of their own questions. Remember you 
can save the tree in this state and come back to it later, i.e. a tree with all the 
questions already in place and all the items just waiting to be sorted.

Try giving the tree to another group of children and let them work through it by 
answering the questions. 

In a review session they can establish if they had any problems or if any of the 
questions were ambiguous. Did they produce the same tree? Were the items in the 
same place and did they manage to identify each item?
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‘Play the Game’
The idea of the sorting game is for the children to think of an item in the tree, click 
on the find button, answer the questions asked for the item they are thinking of 
and see if the tree has the same item in mind as the children.

• Load the Sea Creatures example file, not the picture group.

• Click on the find button on the toolbar (the binoculars).

 This will hide all the pictures from the tree, leaving only the questions.

 The first question in the tree diagram will become highlighted and the Yes and 
No buttons will become visible.

As you answer the questions the path you are taking through the tree becomes 
bolder.

Continue answering all of the questions until the Found Item sheet appears, 
showing a picture of the item and naming it. You are then given the choice of either 
answering Yes or No to confirm if the branching database has found the same item 
that you were thinking of. If you confirm with Yes, then Oscar starts with a new 
find.

If you answer No, then, by default, Oscar will ask you to add a new item to the 
tree using the Add Item sheet. This feature can be configured so that the Add Item 
sheet doesn’t appear.

If the Add Item sheet opens then you can add an item in a similar way as you do 
when creating the tree, except that the new item will now be added to the current 
leaf node rather than at the root of the tree. It is likely that the tree now needs to 
be sorted as there might be two items at the current leaf node.

As you add items to the tree you might also like to save the database otherwise 
you will lose everything that it has learnt.
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Printing
• Click on the print button to open the Print dialogue box:

Oscar’s printing options offers many different ways to print the tree:

• You can print the whole tree diagram out on a single page as shown above. This 
is the default option and is generally suitable when the tree has up to ten items. 
If the tree has many items then the printout may be quite small on a single page, 
in which case...

• You can tile it over a number of pages. The tiled option 
gives the facility of setting the scale of the printout. As 
you increase and decrease the scale the tiling is shown in 
the preview.

 Also, as you add more items to the tree, if the tree 
remains well balanced, then it tends to grow wider rather 
than deeper, in which case...
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• You can print it as a Banner

 This option will print the tree over a 
number of pages and also allows the use of 
continuous feed paper if your printer supports 
it. If you have set your printer to accept banner paper, then you should also click 
the check box labelled Continuous Paper.

Print Items Separately

This feature allows you to use Oscar, to produce 
another useful resource. 

Selecting this option prints the items in the tree on a 
separate sheet of paper along with a printout of the 
tree diagram without the items on it.

This allows you the option of giving the children a 
paper based branching database exercise as a piece 
of work which can be done away from the computer. 
You can either give them the tree and the pictures, 
or just the pictures, and ask them to construct a 
branching tree.

 

Electric guitar
 

Harp
 

French horn
 

Bagpipes
 

Drum Maracas

 Musical Instruments

Is it electric?

Yes No

Is it made of brass?

Yes No

Do you hit it?

Yes No

Do you blow into it?

Yes No

Does it have strings?

Yes No
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Minibeasts Example
Resources required:

• Ask Oscar branching database application

• Minibeasts example picture group

• A printout of the Minibeasts example file, see the printing section on page 11.

• Additional minibeasts graphic files.

Skills required:
Observational; ability to develop and frame a question.

Knowledge; names of some common minibeasts and their characteristics.

The children need to be aware that questions with ‘Yes / No’ answers can be 
used to divide a set of objects into two groups and that a sequence of ‘Yes / 
No’ questions will eventually identify an object. You may wish to discuss the 
minibeasts with the whole class before they begin to create their branching 
database.

• Launch Ask Oscar and add the Minibeasts picture group into the tree.

Try to encourage the children to look carefully at the pictures and to choose a 
question that clearly differentiates between the items.

There are more items in this example and producing a well balanced tree is going 
to be more difficult.

• Click on the sort button and begin to enter the questions that will sort the 
minibeasts. Try to make the questions as short as possible as this will make the 
tree diagram a little more manageable.

Suggestions for questions:
Does it have wings?
Does it have 4 wings?
Is the body as long as the wings?
Does it have a striped body?
Does it have legs?
Does it have more than 6 legs?
Does it have antennae?
Does it have a shell?
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How to Make a Tree Without Questions
You can create a tree without any questions and ask the children to try to think of 
what each question might be.

The example file Minibeasts Without Questions illustrates this point.

To create such a tree;

• Load a set of items, either your own or one of the supplied picture groups.

• Click the sort button.

• Each time a question is prompted for just click on the OK button.

 You will need to work out your question strategy prior to constructing the tree 
in order to ensure that you place the animals into the correct branches and leaf 
nodes. It then remains for you to drag and drop the animals into the correct 
places in the tree diagram.

 Alternatively, you could enter the questions as normal, and then when the tree is 
complete and sorted you can go back and change all the text for the questions 
to be empty.

 You will then have a tree similar to the diagram below:

 

Minibeasts

Dragonfly

Bee Butterfly

?

Yes No

?

Yes No
Fly

?

Yes No

Ant Spider

?

Yes No

?

Yes No

Snail Slug

?

Yes No
Worm

?

Yes No

?

Yes No

You could print this out and give it to the children to try to determine the questions 
and reasoning behind the positioning of the items or modify it on screen.

To modify a question;
• Hold down the Control key and click over the question you wish to change and 

choose the item Change Question...

• Enter the new question and click OK.
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Advanced Features
The ‘Cor Factor’
Using two features; Ask Oscar’s drag and drop and the question and answer 
editing facilities can further extend work.

Unlike many tree programs, with Ask Oscar it is easy to drag and drop items 
around the tree. Questions can be modified or deleted and the Yes and No 
responses can also be changed.

• Launch the Ask Oscar application and load the Sea Creatures example file, (not 
the picture group).

 You may need to alter the scale of the tree using the zoom buttons on the 
toolbar in order to see all the items.

 The tree will appear as shown below:
 

Walrus Dolphin

Can it live on land?

Yes No

Prawn

Plaice Seahorse

Has it got spots?

Yes No

Does it have legs?

Yes No

Is it a mammal?

Yes No

Starfish

Crab Whelk

Has it got claws?

Yes No

Star shaped?

Yes No

Mussel Razor

Lives on rocks?

Yes No
Anemone

Live in a shell?

Yes No

Moves freely?

Yes No

Does it swim in open water?

Yes No

Although the tree is currently sorted, one might suggest that the Prawn might be 
better sited in another part of the tree, or that the plaice does not really swim in 
open water as it spends most of its time on the sea bed.

• Drag and drop the Prawn to the Moves freely? question.

 You will see that as you drag the prawn around the tree, the nodes’ target boxes 
highlight showing where the item can be dropped. If you don’t drop an item on a 
target box then that item will fly back to where it was.

 The tree is no longer sorted.
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• Click the sort button.

 You must now answer the questions in this part of the tree until the prawn 
reaches a point where you will have to enter a new question to differentiate it 
from another sea animal.

You may end up with the prawn at the same node as the crab. So now we need to 
ask, how can we tell a crab from a prawn?

Question suggestion: “Is its body segmented?”

Once you have entered the new question and answered it appropriately the tree 
will once again be sorted. However, there is something else you might notice. The 
question “Does it have legs?” is no longer needed as its “Yes” branch does not 
have anything attached to it. Ask Oscar will allow you to delete this question.

• Hold down the Control key and click on the question, “Does it have legs?” and 
choose the item Delete Question from the pop-up menu.

 The tree will now morph into its new structure.

How Do I Change the “Yes” & “No” Answers?
There might be instances where there are two clear differences between items that 
the children wish to express as a specific answer rather than just Yes or No.

For example; “Is the pupil a boy or a girl?” The answers they might want are either 
“Boy” or “Girl”.

• Launch Ask Oscar and add the picture group Birds to the new tree.

The birds could first be divided into those which are water birds and those which 
are land birds.

• Click on the sort button and enter the question, “Land or Water Bird?”

• Drag the water birds into one group and the land birds to the other it doesn’t 
matter which group is water or land.

• Cancel the New Question sheet that appears again and hold down the Control 
key and click on the question, “Land or Water Bird?”

• Choose the Change Yes Answer... from the pop-up menu and change it to either 
“Water” or “Land” depending on where 
you dragged each group. Remember the 
‘Yes’ answer is always the left branch of 
the question.

• Repeat this for the ‘No’ answer.

• Now click on the sort button and 
complete the rest of the tree diagram.

 

Trogon Swan Frigate Blackbird Robin Goose

Land or Water Bird?

Water Land
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Starting with Two Objects
Initially begin by introducing just two objects. This might focus the children’s 
thoughts when trying to establish a difference between the two items. It is worth 
noting that although the focus might be more direct initially, as more animals are 
added it is possible that questions that seemed ‘obvious’ to begin with now cause 
problems. We should stress that with careful question preparation prior to the 
construction of a database this situation should not arise or at the very least you 
will be aware of some of the problems that the children might need to be guided 
around.

Ask Oscar’s flexible features allow children to move items around the tree diagram 
and replace and delete questions.

• Launch the Ask Oscar application and open the Add Item sheet.

• Click on the Load Picture... button and locate the Minibeasts folder.

• Load the two minibeasts Snail and Ant. You will need to open the Add Item 
sheet twice to do this.

• Click on the sort button on the toolbar

• Enter the question, “Does it have legs?” and click OK.

• Separate the two items into the two groups.

• Next add another minibeast to the tree by again using the Add Item dialogue. 
Add the picture file Slug.

• Click on the sort button and answer the question, “Does it have legs?”

• Move the slug into the No box.

 As there are now two minibeasts at this node you will need to add another 
question in order to differentiate between the slug and the snail.

• Enter the question, “Does it have a shell?”

• Move the animals accordingly.

 There are a number of other minibeasts that can be added from this picture file 
set in the same way.

 Try them in this order;

• Add item: Butterfly  Add question: “Does it have wings?”

• Add item: Spider  Add question: “More than 6 legs?”

• Add item: Worm  Add question: “Does it have antennae?”

• Add item: Dragonfly  Add question: “Body as long as wings?”

If you print this tree diagram you will see that it differs slightly from the one we 
looked at in the first example. This can be attributed to the fact that each item was 
added to the tree one at a time and the questions do not necessarily divide the tree 
roughly into two groups at each question.
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Look No Pictures
Ask Oscar is capable of producing a branching database that does not contain 
pictures.

Load the example file Numbers.

The file was created by clicking on the ‘Add item’ button and typing in the required 
numbers, each in turn. It is then a matter of determining the questions that need to 
be asked. Alternatively you could use words instead of numbers.

This feature can be used when you do not have a picture of an object to add to a 
tree diagram.

Exporting the Tree Diagram
The tree diagrams produced by Ask Oscar can be copied to the clipboard and 
pasted into another applications such as a word processor.

To do this either;

• Choose the Copy item from the Edit menu or use the keyboard shortcut ⌘C.

• Switch to the application where you wish to paste the tree diagram and use the 
appropriate command to paste the picture. Typically this will be ⌘V.

Multiple Undo
The Macintosh version of Ask Oscar fully supports multiple undo and redo. This 
means that you can undo and redo any of your changes to the tree. So do not 
worry when you delete an item or question from the tree and that you don’t get a 
prompt to confirm that you really want to do this as you can just undo this action if 
you wish.

To undo an action either;

• Choose the Undo item from the Edit menu or use the keyboard shortcut ⌘Z.

To redo an undo, either;

• Choose the Redo item from the Edit menu or use the keyboard shortcut ⇧⌘Z.

Customizing the Toolbar
You can add and remove items from the toolbar if you wish. To do this;

• Choose the Customize Toolbar... item from the View menu.

 A sheet will open that allows you to add, remove or just move items around the 
toolbar. You will note that you can also add Undo and Redo buttons. These are 
not part of the default set of items on the toolbar but you may find it useful to 
add them.
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F.A.Qs
Q I can’t see the entire tree diagram, what can I do?

A Some screen resolutions might not be able to display the entire tree diagram. If 
you just want to look at a particular area of the tree you can scroll to it using the 
scroll bars in the usual way or use the arrow keys to move the visual area in the 
window.

 If you want to see the entire diagram then you will need to ‘zoom out’. There are 
two zoom buttons on the toolbar, the one with the + sign will zoom in and the 
one with the – sign zooms out.

Q How can I use the tree diagram in my word processor?

A Oscar supports copying to the clipboard. You can use the Copy Tree to 
Clipboard item in the Tree menu or the keyboard shortcut ⌘C or choose Copy 
from the Edit menu.

Q Can I view the tree diagram ‘growing up’?

A Yes, Ask Oscar has a feature that allows you to orientate the tree diagram in the 
other direction. Open the View menu and choose either Tree Grows Up or Tree 
Grows Down.

Q What can I configure?

A Using the keyboard shortcut of ⌘, access is gained to the Preferences dialogue. 
From here you can alter the following;

• The font and its size used in the tree diagram.

• The colour of the Yes branch, by default this is green.

• The colour of the No branch, by default this is red.

• Highlight Colour – This is the colour of the box that is drawn around the item or 
group of items relating to the current question being asked. The default is blue.

• Tree Grows Down or Tree Grows Up – This changes the view of the tree diagram 
when the application is started. The default is for the tree to grow down.

• Items can be added with ‘find’ – When this is checked it allows the children to 
add an item to the tree if Oscar cannot find the item they are thinking of when 
using the find feature. The default is switched on.
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Q How do I print a continuous Banner?

A Continuous banners can only be printed with a printer capable of doing this. You 
should check with the printer specification to ensure it can cope with continuous 
feed paper.

 You must then set the printer’s settings in its software to allow it to print 
banners.

 The controls in Ask Oscar’s print sheet only change the amount of overlap that 
is printed. When the Continuous Paper button is switched off, a few millimetres 
of overlap is printed to allow pages to be taped together, when the Continuous 
Paper button is switch on then there is no overlap.

 

Q How do I add new picture sets?

A You need to be logged on as an administrator in order to create folders and add 
files for all users to access.

 Using the Finder, open the root folder of the hard disc, and then these 
successive folders, Library, Application Support, Ask Oscar, Picture Groups. 
Here you will find the folders that make up the picture groups. To add a new 
group simply create a new folder with the name you wish to give to the group. 
Then, inside your new folder, add any picture files that you wish to add to that 
group. It’s as easy as that! Oscar supports most graphic file formats, including 
JPEG, TIFF, GIF and PDF. The name of the picture will be taken from the name 
of the file, so you may wish to rename the file appropriately, the file’s extension 
is ignored.

 Next time you open the Add Picture Group sheet you will see your new picture 
group in the list. These picture groups will be accessible by every user on the 
computer.

 For system administators that want to get a bit more involved...

 Oscar checks through all the domains that are defined on the Mac OS X system. 
In order of priority, they are: User, Local, Network and System. The Ask Oscar 
installer only uses the Local domain. The picture groups must be located for 
each domain in

 Library/Application Support/Ask Oscar/Picture Groups

 This means that you could have a global set of pictures for all users in the Local 
domain and bespoke picture groups for users in their own domain. You can also 
use the Network domain too if you so wish. You should not create any such 
folder structure in the System domain as this is reserved for use by Apple.

 If a picture group with the same name is found further down the domain search 
path then that will be used instead of the first one.
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